Troubleshooting a Cisco Business Wireless
Mesh Network

Objective

This document will cover several areas to analyze when troubleshooting Cisco Business Wireless
(CBW) mesh networks.

If you have a traditional wireless network, you should check out Troubleshooting a Traditional
Cisco Business Wireless Network.

Applicable Devices | Firmware Version

- 140AC (Data Sheet) | 10.1.1.0 (Download latest)
- 141ACM (Data Sheet) | 10.1.1.0 (Download latest)
. 142ACM (Data Sheet) | 10.1.1.0 (Download latest)
- 143ACM (Data Sheet) | 10.1.1.0 (Download latest)
- 145AC (Data Sheet) | 10.1.1.0 (Download latest)
.- 240AC (Data Sheet) | 10.1.1.0 (Download latest)
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o Access to the Primary AP Tech Support Bundle
. Adjust one of the CBW Mobile Phone Settings
. If all else fails, reset to factory default settings

Introduction

Mesh wireless networks are awesome, but let’s face it, things happen! Just like any wireless
network, a number of things can cause problems. Sometimes there is a simple fix, while others
might be more complicated.

If you are unfamiliar with terms in this document, check out Cisco Business: Glossary of New
Terms.

For optimum performance and reliability, keep these in mind!

1. Make sure the area has full coverage for the expected number of clients and their
applications. Additional wireless access points may need to be added in order to smooth out
the performance across your total wireless infrastructure.

2. Be aware of the types of applications they may be using (or as an administrator, the types of
applications you may allow).

3. Clients running video streaming applications consume more bandwidth than those that may
be streaming audio-only programs. Video applications rely on buffering to provide a decent
experience.

4. Clients running voice-related applications require immediate service with no delays while not
being as bandwidth-intensive. Since there is no buffering with a voice call, it is very important
that packets are not dropped.

Ready for some troubleshooting? Let’s dig in!

This toggled section highlights tips for beginners.

Logging In

Log into the Web User Interface (Ul) of the Primary AP. To do this, open a web browser and enter
https://ciscobusiness.cisco.com You may receive a warning before proceeding. Enter your

credentials.You can also access the Primary AP by entering https://[ipaddress] (of the Primary AP)
into a web browser.

Tool Tips

If you have guestions about a field in the user interface, check for a tool tip that looks like the

following:

Trouble locating the Expand Main Menu icon?

Navigate to the menu on the left-hand side of the screen, if you don’t see the menu button, click

this icon to open the side-bar menu. e
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Cisco Business App

These devices have companion apps that share some management features with the web user
interface. Not all features in the Web user interface will be available in the App.

Download iOS App Download Android App
Frequently Asked Questions

If you still have unanswered questions, you can check our frequently asked questions document.

FAQ

When troubleshooting, why not start with the basics?

Check Physical and Environmental Conditions

This is the easiest way to troubleshoot but is often overlooked. Even though these may appear to
be obvious, it is good to start with the basics.

. Is all the equipment turned on?

. Is there power to everything?

. Do you have a link light on consistently? Green lights are a good sign!

. Are the cables connected correctly?

. Could it be a bad cable?

. Is any of the equipment overheated?

. Could there be environmental factors such as where it is located?

. Are there metal or thick walls between the AP and the wireless device?

. If the client is completely unable to connect, could the client be out of range?
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Other Items to Consider

1. Restart the AP
2. For APs connecting to a switch, check the switch configuration and verify that the switch is
running in good health. The CPU utilization, temperature, and memory utilization should be
below the specified threshold levels.
3. On the Web Ul, under Monitoring, check the Wireless Dashboard to gather information on
performance and other issues.
. Enable Bonjour and Link Layer Discovery Protocol (LLDP) on the router if it is available.
. Enable Wireless Multicast Forwarding when available for gaming and streaming applications.
. Make sure all Primary Capable APs are on the same VLAN.
. If you've logged into the Primary AP via wireless, and you edit certain settings, such as the
VLAN, you may be disconnected. Connecting to the Primary AP via wired allows that
connection to remain more stable.
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Number of SSIDs

Every SSID requires sending a beacon frame every 100 milliseconds (ms), which can eat up a lot
of channel utilization.

It is best to limit the total number of SSIDs on the AP to 1-2 SSIDs per radio or per AP, even
though the mesh network can support up to a physical limit of 16 SSIDs per radio.
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Are you having trouble logging into the Primary AP?

Perhaps you have tried to log into ciscobusiness.cisco, and are encountering problems. Check out
these simple suggestions:

- If you just completed Day Zero configurations, close the app and then re-launch it.

- Make sure the correct Service Set Identifier (SSID) is selected. This is the name that you
created for the wireless network.

- Log into the Primary AP with https://<IP address of the Primary AP>. The Primary AP address
is the assigned IP address you used in the initial set up procedure. If you opted out of
assigning a manual address at that time, check your router for the DHCP IP address given to
the Primary AP management page. The management address will be assigned on MAC
address 00:00:5e:00:01:01.

- Once you do initial setup, be sure https:// is being used whether you are logging into
ciscobusiness.cisco or by entering the IP management address into your web browser.
Depending on your settings, your browser may have auto-populated with http:// since that is
what you used the very first time you logged in.

- The problem might be your web browser. For example, in Firefox you would click on the menu
at the top right of the screen. Select Help > Troubleshooting Information and click on
Refresh Firefox.

- Disconnect any Virtual Private Network (VPN) for either the mobile app or on a laptop. You
might even be connected to a VPN that your mobile service provider uses that you might not
even know. For example, an Android (Pixel 3) phone with Google Fi as a service provider
there is a built-in VPN that auto-connects without notification. This would need to be disabled
to find the Primary AP.

- If you have an Android phone, you may be using a private Domain Name Server (DNS) and
may need to disable this feature for connectivity. To check this, you can typically find this
under Settings > Network and Internet > Advanced > Private DNS.

Do you have the latest version running on your APs?

Why It's Important

Firmware, also referred to as software, comes embedded on your access point. Upgrading
firmware improves the performance and stability of your AP. Upgrades may include new features
or fix a vulnerability that was experienced in the previous version of the software. Is it really that
important? Absolutely! It is so vital that all the links for upgrades were added in the Firmware
Version section of this article. This could be a simple solution to try if you are having network
problems. You may have issues when adding the first Mesh Extender to a network if there is a
firmware version mismatch, so why not update them all right away!

It is extremely important to update all Mesh Extenders before updating the Primary Capable APs.

You can upgrade the firmware in a number of ways, but it is recommended that you use
Cisco.com for the upgrade. If you would like assistance in upgrading firmware, check out Update
Software of a Cisco Business Wireless Access Point.

Upgrade Troubleshooting
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Sometimes an upgrade doesn’t go smoothly. There are some simple things you can try:

1. Refresh or close the web browser.

2. Clear the browser cache and re-log into the Primary AP. The process for this varies based on
the web browser you use.

3. Click on an alternate page or tab in the Primary AP Web User Interface (Ul) and then go
back to the Software Update page and try the firmware image download again.

4. Try a new web browser. For example, if you were using Chrome and it isn’t working, try
Firefox.

5. On rare occasions, if the management page failed to start the firmware upgrade or is
unresponsive (no status change after initiating upgrade), it may be necessary to power off/on
all the access points and mesh extenders on the network and retry the firmware upgrade.

Do any of these situations apply to you?

- If you are using the downstream Ethernet port on the CBW240, switch to another port.

- If you are using captive portal, avoid using Chrome-based browsers, including Microsoft Edge.
Sometimes you may not be able to joing the network. It might be as simple as using Firefox as
your browser.

- If a client is using a VPN connection without split tunneling/split DNS, the CBW management
page may be inaccessible and the mobile app may not function. Try temporarily disabling the
VPN on the client to access CBW management functions.

- If private DNS is enabled on the client, DNS queries are encrypted and CBW cannot intercept
them. This will prevent the Cisco Business mobile app from working and will prevent
ciscobusiness.cisco from resolving. It is recommended that you either manage CBW from a
client joined to the network without private DNS, or manage CBW using the Web Ul via the
management IP address.

- Make sure CBW devices are not set up in the same VLAN as a Cisco Wireless LAN
Controller.

Could it be a connectivity issue?

Run Connectivity Tests from the Web User Interface (Ul)

The AP must be able to communicate with other devices to be effective. A simple way to check
this is to perform a ping.

Ping the AP from at least two clients that are connected (associated) to that particular access
point.

Ping from the router to the access point IP address to see if end-to-end connectivity is available.
Ping from the router to the wireless clients associated with the AP to check if they can be reached
from the main network.

Potential DHCP Problems

Even though you probably assigned a static IP address to your Primary AP, this AP still needs to
have access to a DHCP server. This DHCP server must be operational and reachable from the
LAN Ethernet port of the AP. This is necessary so the Primary AP can provide IP addresses for all



APs and clients that join the network. If you see a blinking red light on the Primary after a reboot,
this could be your problem.

Even though a static IP address can be chosen for CBW management, it only applies to the
managemetnt IP address. Every access point, including mesh extenders need a separate IP
address for its access point functionality. The management MAC address is 00:00:5e:00:01:01.

Even if all CBW addresses are configured as static, adding a new AP or mesh extender still
requires a DHCP server for the initial installation of the new device, even if you plan to change it to
a static IP address later.

It's possible that there are more clients needing an IP address than are available in the DHCP
pool. See the section How to View or Change the Pool of IP Addresses for DHCP section the
article Best Practices for Setting Static IP Addresses on Cisco Business Hardware for more
information.

There may be times where too many DHCP addresses are cached, which can also prevent clients
from getting an IP address. To learn more about this, check out Tips to Keep the ARP Table
Available for DHCP IP Addressing. You may also reboot the router if this is more convenient.

Windows Support

If you use Windows, select your wireless connection from the Network Connections panel and
verify that its status is Enabled.

Detailed guidance can be found at the Microsoft Support Forum for troubleshooting wireless
network connectivity at the clicking on the following link: Fix Wi-Fi connection issues in Windows.

Maybe the CBW settings need to be adjusted

There are some default settings that might cause connection issues in some older devices. You
can try changing the following settings.

RF Optimization
Step 1
Make sure you are in Expert View for these settings.
?7 Q A © =) & &
Step 2
Navigate to Advanced > RF Optimization. Toggle on RF Optimization.
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Step 3

Scroll down to the bottom of this screen. Within each radio Data Rates, remove support for lower
control rates to remove older legacy wireless mode clients, such as 802.11b clients.

Lower Density Higher Density

i

2.4 GHz Data Rates

kY

1 25 6 9 1 12 18 2 *» a5
Maximum Device Capability
Lower Density Higher Density

5.0 GHz Data Rates _

B 9 12 1B 24 3 48 54

No connectivity for some legacy devices

Step 4

A notification will come up that older devices are not supported. The further to the right you slide,
the less that can connect.

Lower Density Higher Density

i

2.4 GHz Data Rates

1 2556 9 1 12 18 4 3% 48 54
802.11b devices not supported
Lower Density Higher Density
5.0 GHz Data Rates _
6 9 12 18 24 il 45 )

Some legacy devices not supported

Bridge Group Names
If you set up your network with all APs at factory default

When you conducted the Day Zero configurations for your mesh network, a BGN was
automatically created. It is the same as the first Service Set Identifier (SSID) you entered, up to
the first 10 characters. This BGN is used within APs to associate and make sure the APs are
staying connected properly. If you set up your Primary AP and then join subordinate APs, the BGN
should automatically match with no further configurations needed.

If you reset a Primary AP or moved a configured AP to a new network

If you perform a reset to factory default on the Primary AP, or move APs from one configured
network to another, this can cause a mismatch of BGNs.

When an AP tries to join a network in a scenario where the BGN doesn’t match any networks
available, the subordinate AP will still attempt to temporarily join the network with the strongest
signal. The AP will be able to join the network if it is Allow Listed and approved.

Once the AP has joined the network, since the BGN doesn’'t match, the subordinate AP will
continue to look for a matching BGN every 10 to 15 minutes. This will cause the connection to
drop and then join again if a matching BGN isn’t found. This can cause a lot of problems with
connectivity in the wireless network, especially when there might be a stronger wireless signal
coming from another wireless network.

As a simple solution, for all APs to work together, you should make sure the BGN on all APs
match exactly. To clear out the BGN on the other APs, you can do a factory reset on them, or you
can manually change each one to match.



If you want to view or change a Bridge Group Name (BGN) on an AP

It is recommended that BGNs get assigned to the mesh extenders with the most hops be
configured first, working up to the least number of hops. After that, the Primary Capable APs
BGNs should be assigned. The Primary AP BGN should be configured last. You can view and
change them one at a time by performing the following steps.

Step 1

Log into the AP and enter your credentials.

Cisco Business

Cisco Business Wireless
Access Point

Welcome! Please click the login button to enter your user name and password

@ 2015 - 2020 Cisco Systems, Inc. All rights reserved. Cisco, the Cisco logo, and Cisco
Systems are registered trademarks or trademarks of Cisco Systems, Inc. andior its

affiliates in th and certain other countries. All third party trademarks are the
property of their respective owners

Switch to Expert View by clicking on the arrow icon.
A 2 - o
Step 3

Navigate to Wireless Settings > Access Points. Click on the edit icon of the AP you want to edit
or view.
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Step 4



A pop-up will ask for confirmation that you want to edit the AP configuration. Select Yes.

Edit AP

Access Point Radio(s) is in enable state. Editing the AP configuration
will disrupt the network momentarily. Do you want to continue.?

Step 5

Click the Mesh tab. Here you can view and change the Bridge Group Name. If you make changes,
be sure you click Apply.

APA453.0E1F.E488(Active Master AP)

General Master AP Radio 1 (2.4 GHz) Radio 2 (5GHz) Mesh

AP Role | oot
Bridge Type = lndoor
Bridge Group Name EZ1K 9 (2]
Strict Matching BGN
Backhaul Interface | G058 Tlaiac
Install Mapping on Radio ()
Backhaul
Ethernet Link Status = P

Mesh Backhaul Slot €

(® 5GHz () 2.46H:z
Ethernet Bridging

Enable ()

Acti... Interface Name Oper Status Mode VLAN Id

0 n No items to display
o a

Step 6

Repeat the steps for each AP in the network you want to check. Click the save icon to
permanently save any changes. Keep in mind that when a bridge group name is assigned, the
device performs a reboot. Since a reboot interrupts Wi-Fi, it is not recommended during business
hours.
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Allow Lists



In order to connect other Primary-capable APs and mesh extenders, you need to create an Allow
List on a Primary AP that includes the Media Access Control (MAC) address of all the APs.

In addition, subordinate APs need to be Allow Listed so that the Primary AP can access and
upgrade the other APs, which is essential to keep the network up and running.

This Allow List, along with all APs having the same Bridge Group Name (BGN), helps the APs
connect efficiently and consistently. To add a Media Access Control (MAC) address and label it as
Allow List, complete the following steps.

Step 1

You need to know the MAC address of the AP. If you know the MAC address of your AP, you can
skip to Step 4.

A MAC address includes numbers and letters in pairs, separated by colons.
Step 2
On most APs, the MAC address can be found on the outside of the actual AP. On the 142ACM

and 143ACM you need to slide out the power apparatus to view the MAC address. To do this,
apply light pressure on the AP where the arrows indicate. Slide and lift the power component out.

Step 3

On the 142ACM and 143ACM, you will see the MAC address in the locations pointed out below.
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Step 4

1. Select Wireless Settings

2. Select WLAN Users

3. Select Local MAC Addresses
4. Select Add MAC Address

thah
e 'c||5'clol Cisco Business Wireless 140AC Access Point ? X Q |Qworciensea

-7 Monitoring

1
'Q' Wireless Settings
N WLANs WLAN Users

% Access Points E 0

U Access Points
Groups

L 2

WLAN Users  Local MAC Addresses
% Guest WLANs

¥ Mesh

Search 0
ﬁ" Management e @ Add MAC Address || Refresh 'i‘ fi Number of Blacklist:0 Number of Whitelist:2
[ 4 q
, SEFVICES Action MAC Address Type Profile Name Description
* AdVanced & x 68:ca: WhiteList Any WLAN/RLAN CBW142 Mesh Extender
& x a4:53 WhiteList Any WLAN/RLAN CBW140AC-e488
10

Step 5

Enter the following information:

1. MAC Address

2. Description (up to 32 characters)
3. Select the Allow List radio button
4. Click Apply

Add MAC Address

o MAC Address | a4:52:0f1e:16:5a

9 Description ~ ACM141 7]

Type O BlackList @ WhiteList 9

Profile Name Any WLAN/RLAN

o
Interference and spacing considerations

Rogues, Interferers, and RF Channels...oh my!

Interference can cause issues on wireless networks and can come from more sources than ever
before. Microwaves, security cameras, smartwatches, motion detectors, or even fluorescent bulbs
can cause interference.



How much they affect the network can depend on many factors including the amount of power
emitted if the object is constantly on, or if it is intermittent. The stronger the signal or the more
frequently it is on the more problems that can arise.

Rogue APs and rogue clients can cause problems if there are too many on the same channel as
well.

Interference can be a major inhibitor to wireless performance, creating security vulnerabilities and
wireless network instability.

There are tools available to monitor the channel(s) you are currently utilizing. You have the
ability to change channels as well. Check out the following articles for more information.

- Identifying Rogue Clients
. ldentifying Interferers
. Changing RF Channels

Recommendations for Spacing and Deployment

1. Place Mesh Extenders in line-of-site of Primary-Capable APs.

2. Downstream Mesh Extenders in line-of-site of parent Mesh Extender.

3. Downstream Mesh Extenders require good/excellent on backhaul SSID signal strength from
upstream Primary-Capable APs.

4. Mesh Extenders should have a minimum Signal to Noise Ratio (SNR) value of 30.

5. Avoid placing Mesh Extenders too close to other Mesh Extenders or other Primary-Capable
APs.

The following chart lists the expected coverage areas in an open space. If you deploy your
network in an area that is not open, reduce these values by 20-30%.

Model Recommended Distance Recommended Distance
(VEES) (Feet)
CBW240AC 18 - 21 60 - 70
CBW140AC 15-18 50 - 60
CBW145AC 15-18 50 - 60
CBW141ACM 15-18 50 - 60
CBW142ACM 10-13 32 - 42
CBW143ACM 10-13 32-42

Signal to Noise Ratio Between “Hops”

In all networks, you need to work on a strong signal between clients and the APs. In a mesh
network, you also need to make sure there is a strong signal between the various APs between
each other. If one of the “hops” doesn’t have a great signal, a higher signal to noise ratio, you will
need to troubleshoot that. You may need to adjust the location or check to see what is causing
interference.

Step 1

Navigate to Monitoring > Network Summary > Access Points and click on any access point in
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the table to check the associated client signal strength.
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Step 2

Once the Access Point View opens, look over the information under Performance Summary.
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Step 3

You can also gather information on all mesh extender Hop counts and Signal to Noise Ratio.

Access Point View

GENERAL

MAC Address
Base Radio MAC
IP Address
CDP/ LLDP
Ethernet Spead
Model / Domain
Power status
Serial Number

Max Capabilities

Tech Support

Tech Support Status

AP Name
AP6CT71.0D55.73C4
Location

default location

6c.71:0d:55:73.c4
a4:b2:39:df:11:20
192.168.1.29
c47d4fece3s2, git
1000 Mbps
CBW145AC-B / 802.11bg:-A 802.11a:-B
PoE/Full Fower
FGL2418L84T
802.11n 2 4GHz,802 11ac 5GHz
Spatial Streams : 2 (2.4GHz), 2 (5.0GHz)
Max. Data Rate : 144 Mbps(2.4GHz), 867
Mbps(5.0GHz)
Start Dewnload

Mot Started

PERFORMANCE SUMMARY

2 4GHz

5GHz

Number of clients
Channels

Configured Rate

0

"

(36, 40, 44, 48)

Min: 1 Mbps, Max: 144 MbpsMin: 6 Mbps, Max: 867 Mbps

Usage Traffic 9.8 MB 3.9 GB
Throughput ] 14.5 KB
Transmit Power 20 dBm 18 dBm
Noise Not Available Not Available
Channel Utilization 65% 12%
Interference 59% 0%

Traffic 6% 12%

Admin Status Enabled Enabled
Interferer Detection Up up

Navigate to Monitoring > Network Summary > Mesh Extender.

*R Monitoring @

Access Points
Clients

Guest Clients

O Applications

« Rogues

22 Network Summary @

Take a look behind the curtain

) ) ) ) 0 =
e cisco Cisco Business Wireless 145AC Access Point Q A © = ¥ o
?
AP Name AP Model Ethernet M... = Parent AP ... Hop Link SNR (... Channel Ut... | Channel Clients
AP6C71.0D CBW141AC...  6c:71:0d:55 AP6C71.0D 1 25 5 (36,40,44,48) 0



Syslogs

Being aware of events can help ensure the network runs smoothly and prevent failures. Syslogs
are useful for network troubleshooting, debugging packet flow, and to monitor events.

These logs can be viewed on the Web User Interface (Ul) of the Primary AP and if configured, on
remote log servers. Events are typically erased from the system when rebooted if they are not
saved on a remote server.

If you would like more information, check out Setting Up System Message Logs (Syslogs) on a
CBW Network.

Support Bundle

A feature that is available on this CBW equipment is to download a support bundle. A support
bundle is a tool that can be helpful in troubleshooting. It provides the AP boot-up logs and
specifies the configurations applied. To get a complete picture, this might need to be done on
every AP.

Before downloading the support bundle on the Primary AP, make sure you are running the most
current release of firmware. To update firmware, select the correct link under Applicable Devices |

Firmware Version. If you would like assistance in upgrading firmware, check out Update Software
of a Cisco Business Wireless Access Point.

Step 1

To download the tech support bundle specific to access point functionality, select Monitoring >
Access Points. Select the AP you would like to access.

thah 2
e 'C|IS'C|°' Cisco Business Wireless 145AC Access Point ? Q A @ u ¢

@* Monitoring

B2 Network Summary

. Access Points

Clients

i 5GH:
Guest Clients aEZl» =

Mesh Extender

Master AP Mesh Extender

O Applications
AP Name ~ Type ~ | Clie.. ~ | Usage ¥ | Uptime ~ | Adm.. ¥ Ope.. ¥ N Tran.. ~

! Rogues stat... Stat... Power

Access Points

APGC71.0D55.73C4 Master AP 0 9.8 MB 1days, 02h 17 m Enabled UpP 1" 20 dBm
Clients

APGC71.0D55.5DA4 Mesh Exten 0 12.4 MB 6 days,23h22m Enabled UpP 1 20 dBm
® Wireless Dashboard

AP Performance n
4 booH

Step 2

Under the Tech Support section, select Start.

e
9 lcllslclo' Cisco Business Wireless 145AC Access Point

Access Point View

GENERAL

AP Name

AP6C71.0D55.73C4

Location


https://www.cisco.com/c/en/us/support/docs/smb/wireless/CB-Wireless-Mesh/2064-Setting-Up-System-Message-Logs-CBW.html
https://www.cisco.com/c/en/us/support/docs/smb/wireless/CB-Wireless-Mesh/2064-Setting-Up-System-Message-Logs-CBW.html
https://www.cisco.com/c/en/us/support/docs/smb/wireless/CB-Wireless-Mesh/2063-Upgrade-software-of-CBW-access-point.html
https://www.cisco.com/c/en/us/support/docs/smb/wireless/CB-Wireless-Mesh/2063-Upgrade-software-of-CBW-access-point.html

Step 3

When the download is complete, you will see the Tech Support Status is Completed. Select the
Download button to download the files. At this point, even if the download happens to falil, it is
deleted from the memory of the AP. This would happen if you don’t allow pop-ups.

Tech Suppaort Start Download
Tech Support Status Completed
Step 4

In the Download folder of your computer files, you will see a tech support .tgz file. The files inside
this folder need to be extracted.

+ | = | Compressed Folder Tools Downloads — O Y
Home Share View Extract e

« “ /4 » ThisPC » Downloads v 0 Search Do... @

MName Date mc:clif\i’r:cl Type Size
# Cuick access
@ OneDrive tech_support_APECT1.0D35.73C4.tgz 6/29/2020 11:07 AM TGZ File 4TKB
Documents

Pictures

W This PC
» 3D Objects
w Desktop
Documents

3 Downloads

b Music

Step 5

Right-click and select the unzip application that you would like to use. In this example, 7-Zip was
used. Select to extract the files to the location you select. By default, the files are sent to the
Downloads folder.



' = | Compressed Folder Tools Downloads - O X

Home Share View Extract
« “ 4~ & » ThisPC » Downloads v 0 Search Do... @
MName Date modified Type Size

o Quick access

@& OneDrive b - 6/29/2020 11:07 AM TGZ File 47T KB
Documents Oveniwti
Pictures ﬂ Open with Code
7-Zip >
W This PC CRC SHA P
s 3D Objects 5 Edit with Notepad++
m Desktop |& Share
% Documents Give access to >
4 Downloads @ Cisco AMP For Endpoints >
b Music Restore previous versions
« Pictures Send to >
| Videos
Cut
29 Windows (C:) o
& Network Create shortcut
Delete
Rename
Properties

1,013 items 1 item selected 46.8 KB

(Alternative View) If you have a core crash, you might see these folders instead.

Name Date modified fype Size
ap-core-crash B/25/2020 7:51 AM File folder
"
ctrl 51 &AM File folder
+ - o -
internal-ap 51 AM File folder
* | tech_support.ter §/25/2020 T:51 AM TAR File 327 KR

Step 6

Once the files have been extracted from the .tgz file, they will be in a .tar file. This file will need to
be extracted again.

| s Compressed FolderTools  tech_support_AP6CT71.0D55.73C4 — [m] X
Home Share View Extract (7]

« v 4 > Search Results in Downloads » tech_support_AP6C71.0D55.73C4 v 0 Search tec... Q0
A Name . Date modified Type
# Quick access
2 tech_support AP6CT1.0D55.73CA tar o 6/29/2020 11:07 AM TAR File
s Documents
4 Downloads o
Open
3] Open with Code
Open archive 7-Zip e >
Open archive > CRC SHA >
Extract files... 2‘ Edit with Notepad-++
Extract Here |& Share
Extract to "tech_support AP6C71.0D55.73C4\" 0 Open with...
Test archive Give access to >
Addto archive. 2 Cisco AMP For Endpoints >
Compress and email... Restore previous versions
Add to "tech_support_AP6C71.0D55.73C4 tar.7z"
Send to >
Compress to "tech_support AP6C71.0D55.73C4.tar.7z" and email
Add to "tech_support_AP6C71.0D55.73C4 tar.zip" Cut
Compress to “tech_support_AP6C71.0D55.73C4.tarzip" and email Copy
Create shortcut
o4 RS 2 Delete
litem  1item selected 53.5KB &= Rename
]
Properties

Step 7

You will see the tech_support folder. Double-click on the folder to open the files.



| ¥ = | tech_support_AP6CT1.0D55.73C4 - O X

Home Share View - 0

« =2 v 4 » Search Results in Downloads » tech_support_APECT1.0D53.73C4 ] Search tec... @
G MName Date modified Type
» Cuick access
[ tech_suppert_APGCT71.0D55.73C4 6/29/2020 2:56 PM File folder ]
4 Documents o —
= tech_support_APGECT1.0D055.73C4.tar 6/29/2020 11:07 AM TAR File

+ Downloads o
« Pictures -+

Step 8

Within the support bundle, the cli_file (configuration file), msg/syslogs (event logs), and startlog
pr(lovide the most relevant information. The files you see may vary. An example is shown here.

ame Date moditied Type
W] APRCT1.00353.73C4_support,10,1,1.0,20200629.110435,wsa_status,json.gz 6/29/2020 11:05 AM GZ File
(W] APBCT1.0055.73C4_support.10.1.1.0.2020062%.110435.wsa_info.json.gz 6/29/2020 11:05 AM GZ File
|| ™| AP6CT1.0055.73C4 _support.10.1.1.0.20200629.110435 tech_support.qz 6/29/2020 11:05 AM GZFile_J
B APGCT1.0035.73C4_support,10,1,1.0,20200629.110435.syslogs.gz 6/29/2020 11:05 AM GZ File
[B] APBCT1.0055.73C4_support.10.1.1.0.20200629.110435 startlog.gz 6/29/2020 11:05 AM GZ File
(W] APBCT1.0055.73C4_support.10.1.1.0.20200625.110435. messages.gz 6/29/2020 11:05 AM GZ File
| AP&CT1.0D35.73C4_support.10.1.1.0.20200625.110435.info 6/29/2020 11:05 AM INFO File
W] APRCT1.0033.73C4_support,10,1,1,0,20200629,110433 brain.log.gz 6/29/2020 11:05 AM GZ File
W] APBCT1.0055.73C4_support.10.1.1.0.20200629.110435.brain.error.log.gz 6/20/2020 11:05 AM GZ File

Step 9

Right-click on the file you would like to unzip. In this example, the file will be unzipped into a folder
for tech_support.

Home Share View Extract ~ o
« v A » Search Results in Downloads » tech_support APEC71.0055.73C4 » tech_support APECT1.0D55.73C4 v O Search tec... 0
-
~ Mame Date modified Type
3 Quick access
PERFORMANCE SUMM o . W] APGCT1,0D55.73C4_support.10.1,1.0.20200629.110435.wsa_status.json.gz £/29/2020 11:05 AM GZ File
o Documents
(W] APECT1.0055.73C4_support.10.1.1.0.20200629.110435.wsa_info json.gz 6/28/2020 11:05 AM GZ File
b Downloads /8 APGCT1.0D55.73C4_support.10.1.1.0. 2011 GZ File
% set inbe: | B A2 Pict ety
=t | M Inbo ‘ = Ficlures bl {8 APECT1.0D055.73C4_support.10.1.1.0. 2011 GZ File
. N , ﬂ Open with Code
- 20 11 GZ File
Open archive T-Zip e > 2011 GZFile
Open archive > RS > b INFO File
Exfract ileas & Edit with Notepad++ 201105 2 57 Fie
Extract Here & Share 20 11:05 AM GZ File
Extract to "APECT1.0055.73CA support.10.1.1.0.20200629.110435 tech supporty” () Open with..
Test archive Give access to >
Add to archive... m Cisco AMP For Endpoints > I
Compress and email... Restore previous versions
Add to "APGCT1.0055.73C4_support.10.1.1. ... 200629.110435.tech_support.gz.7z" 5
Send te
Compress to "AP6CT1.0D55.73C4_support.10.1.1. ... 200629.110435.tech_support.gz.7z" and email enete
Add to "APGCT1.0D55.73C4_support.10.1.1. ... 00629.110435.tech_support.gz.zip" Cut
Compress to "APBCT1.0035.73C4_support.10.1.1, ... 00629.110435.tech_support.gz.zip" and email Copy
Type: # Uocuments Create shortcut
= 4 Downloads Delets
= B9 Sub-task e
b Music Rename
,‘.? Status: . v < >
— M tmms 1 Smm nlenind 112 VD Properties [ =

Step 10

The tech_support folder will appear. Double-click to open the folder.

[ = | tech_support_APECT1.0D35.73C4 - O bt
Home Share View hd e

« = v 4 » Search Results in Downloads » tech_support_APGCT1.0D55.73C4 » tech_support AP6CT1.0D535.73C4 v @ Search tec... @
~ MName - Date modified Type
o Quick access
. Documents # APBCT1.0D055.73C4_support.10.1.1.0.20200629.110435.tech_support 6/20/2020 3:34 PM File folder
' [B] APGCT1.00535.73C4_support.10.1,1.0.20200629.110435.brain.errer.log.gz 6/29/2020 11:05 AM GZ File
4 Downloads  # 18] APECT1.0D55.73C4_support.10.1.1.0.20200629.110435 brain.log.gz £/29/2020 11:05 AM GZ File
= Pictures * | APGCT1.0D55.73C4_support.10.1.1.0.20200629.110435.info 6/20/2020 11:05 AM INFO File
xml * (W] APGCT1.00535.73C4_support.10.1.1.0.20200629.110435.messages. gz //29/2020 11:05 AM GZ File
[B] APGCT1.00535.73C4_support.10.1.1.0.20200629.110435.startlog.gz 6/29/2020 11:05 AM GZ File
(W] APBCT1.0D55.73C4_support.10.1.1.0.20200629.110435.syslogs.gz 6/29/2020 11:05 AM GZ File
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Step 11

Right-click on the file and select a text file reader. In this example, we used Edit with Notepad++.

= | APBCT1.0D55.73C4_support.10.1.1.0.20200629.110435.tech_support — O *
“ Home Share View o
« v <« tech_support_APGCT1.0055.73C4 » AP6CT1.0055.73C4_support.10.1.1.0.20200629.110435 tech_support v O Search AP... 0@
& MName Date modified Type
»& Quick access
AP6CT1.0D55.73C4_support.10.1.1.0.20200629.110435 tach_runna r RGN0 1105 AR TECH_SUPPORT File
i Documents o .
pen with
4 Downloads ’q Open with Code
« Pictures 7-Zip >
xml CRC SHA >
APECT1.0D35.73 &/ Edit with Notepad++
HTML i Share
Timesheets Give access to >
Troubleshooting ﬂ:} Cisco AMP For Endpoints >

Restore previous versions

@ Onelrive
Documents Send to >
Pictures Cut
Co
™ This PC ik

» 3D Objects Create shortcut

w Desktop Delete
i Documents Rename
& Downloads Properties
b Music
v y

1item iitem selected 34.8 KB -
Access to the Primary AP Tech Support Bundle

The Primary AP tech support bundle is the main source of diagnostics. To download the tech
support bundle that is built into the Primary AP or the virtual controller bundle, navigate to
Advanced > Primary AP Tools. Select the Troubleshooting Files tab. Select Download Support
Bundle. For Transfer Mode, select HTTP or FTP. Click Apply settings. Click on the Save icon.

thah 0
) 5 e -c|ls-c|°- Cisco Business Wireless 145AC Access Point ? Q A @ ! Q
@ Monitoring

'!.‘.t- Wireless Settings
Master AP Tools

I'I- Management

& Advanced (]
¥ SNMP

B Logging
.l RF Optimization Restart Master AP Configuration Management  Troubleshooting Files  Troubleshooting Tools Upload File

s @

£ Security Settings

» Tech Support

Support Bundle includes configuration, logs and crash files for trouble shooting.
Pop-up blocker should be disabled in Browser settings to upload or download configuration file.

Transfer Mode | HTTP (Local Machine)

Adjust one of the CBW Mobile Phone Settings



Change the 802.11r settings on the CBW Network

Step 1

Access the Web User Interface (Ul) by entering the IP address of the Primary Access Point into a
web browser. Make sure you are not on a Virtual Private Network (VPN) or this will not work. If you
encounter security warnings, select the prompts to proceed.

C A Notsecure | 192.168.1.124

Step 2

In the upper right-hand of the Web U, click on the opposing arrows to switch to expert view.

A B () = %

[ Switch to Expert View ]

Step 3

A pop-up window will appear, asking if you want to select expert view. Click OK.

192.168.1.124 says

Do you want to select Expert View?

‘ OK Cancel

Step 4
Select WLANSs and the edit icon for the WLAN you want to edit.

e Iéllls'éloh Cisco Business Wireless 145AC Access Point Q A @ = ¥ 0

@ Monitoring

£+ Wireless Settings ?
B\ 1 WLANSs

@ Access Points
N Active WLANs [K]
% Access Points
Groups

& WLAN Users

ﬂ' Guest WLANSs Add new WLAN/RLAN

’ Mesh Action Active Type Name ssiD Security Policy Radio Policy

e[ff X Enabled WLAN cisco_1 cisco_1 Personal(WPA2) ALL -
@ x

@ x Enabled WLAN cisco_4 cisco_4 Personal(WPA2+... ALL
x

@

8 Management

Enabled WLAN cisco_2 cisco_2 Guest ALL

£ Servi
V4 ervices
Disabled WLAN cisco_3 cisco_3 Open ALL

-‘a Advanced

Step 5

A pop-up window will appear, asking if you want to continue. Click Yes.

Edit WLAN




Step 6

Click on the Advanced tab. Click on the drop-down menu for 802.11r and select Enabled.

General WLAN Security VLAN & Firewall Traffic Shaping Advanced Scheduling

Allow AAA Override

802.11r | Enabled e v

Over The DS
Step 7
Click Apply.
Step 8

To permanently save these settings, click the save icon on the top right of your screen.

A B ~ O

If all else fails, reset to factory default settings

An option of last resort, that should only be done to remedy the most severe issues such as losing
the ability to gain access to the management portal, is to perform a hardware reset on the router.

When you reset to factory default settings you lose all configurations. You will need to set up the

router again from scratch so make sure you have the connection details.

The process on the new CBW APs is a little different than you may have experienced on other

APs. For details on the reset, check out the article Reset a CBW AP back to Factory Default

Settings.

Conclusion

It was our intention to give you several different options for troubleshooting your mesh network.

Mission accomplished! You should now have connectivity and can move on with your day.

View a video related to this article...


https://www.cisco.com/c/en/us/support/docs/smb/wireless/CB-Wireless-Mesh/2120-reset-to-factory-default-cbw.html
https://www.cisco.com/c/en/us/support/docs/smb/wireless/CB-Wireless-Mesh/2120-reset-to-factory-default-cbw.html

Click here to view other Tech Talks from Cisco
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